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Chapter 1

General Information

1.1 System Overview

StarPep toolbox has been designed in a user-friendly way for supporting visual network analy-
sis of bioactive peptides of pharmaceutical interest. The bioactive peptides are collected from a
large variety of biological data sources to be organized into an integrated graph database called
starPepDB, where peptide nodes are at the center surrounded by their neighbor nodes repre-
senting metadata (resembling an asterisk or star schema). This integrated graph database is
embedded in starPep toolbox to enable end-user querying, filtering, visualizing, and analyzing the
bioactive peptides taking advantage of network-based representations.

1.1.1 License

This program is free software: you can distribute it and/or modify it under the terms of a dual
license consisting of the Common Development and Distribution License (CDDL) v1.0 and the
GNU General Public License (GPL) v3.

1.2 System requirements

1.2.1 Hardware

e Memory (RAM): A minimum of 4 GB is required, but we recommend 8GB or more.

e Processors: We recommend a multi-core processor due to the fact that the software has
been implemented to enable parallel processing of computationally intensive tasks.

e Hard Disk: a minimum of 500 MB of free space is required.



2 CHAPTER 1. GENERAL INFORMATION

1.2.2 Software
e Java SE Runtime Environment 8.

Note: It does not work (yet) with versions of Java greater than 8.

1.3 Downloading and installing the program

The binary executable files for Windows, Mac, and Linux are located in http://mobiosd-hub.
com/starpep/. You can download the zip distribution and extract it to a folder or use an installer
for the application.

1.4 Issue with java versions

StarPep toolbox does not yet support any version of Java > 8. The requirement is java 8. If you
have multiple Java versions installed on your system, please configure starPep toolbox to run on
the supported one (Java 8). Find the etc/starPep.conf file in the installed directory and configure
the jdkhome="/path/to/jdk” accordingly. The symbol “#” at the beginint of the line means that it is
commented out, please remove it.

1.5 Increasing the memory heap size

You may increase the memory heap further if there is enough RAM available in your system
(recommended). First, you have to switch to the directory where the application has been in-
stalled or extracted. Open the text file “starpep.conf” located under the etc folder. Once the
file has been open, locate the default_options setting and change the min/max heapsize values (-
J-Xms or -J-Xmx). For instance, to increase the memory heap size from 4G to 8G, enter the value:

Before (4G):

default_options="--branding starpep -J-Xms24m -J-Xmx4G"

After (8G):

default_options="--branding starpep -J-Xms24m -J-Xmx8G"

Then save the text file etc/starpep.conf and run the application.


http://mobiosd-hub.com/starpep/
http://mobiosd-hub.com/starpep/

1.6. RUNNING STARPEP TOOLBOX

1.6 Running starPep toolbox

StarPep toolbox can be initiated by running the bin executable files located in the installed directory,
or by clicking the application icon (if installed).

Starting modules

Figure 1.1: Loading screen of StartPep toolbox
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2.1 Main view
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1. Menu bar

2. Quick access bar
3. Tools panel

4. Central panel

5. Properties panel

Figure 2.1: StartPep toolbox main window
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6. Navigator panel
7. Output panel

Note: The above windows panels may be opened from the option in the menu bar.

2.2

2.2.1

Menu bar

File

The following options are accessible from the option:

Note: Workspaces may be used to work with different data models: one per workspace.

Select workspace [workspace,name]‘ Switches to a new workspace

Copy data to )) New Workspace] Duplicates data model to a new workspace

\File Remove workspace )) Remove current workspace} Removes the current workspace
\File Remove workspace )) Remove other workspaces‘ Removes the other workspaces, and only

Clean project} Removes all workspaces and sets the default workspace with the default data

[File )) New workspace| Creates a new workspace
File
File
[File Rename current workspace] Renames the current workspace
[File Remove workspace]
remains the current workspace

File

model
File

Import )) Peptide sequences (FASTA format)} Imports peptide sequences into a new workspace.

Export| Exports the following data

[File Export )) Peptide sequences (FASTA format)}

[File Export )) Molecular descriptors (CSVformat)]

[File )) Export ) Networks (GraphML format)|

\File Export )) Metadata relationships (CSVformat)}

Shutdowns the program

2.2.2

View

The following options are accessible from the option:

. Shows/hides a quick access bar.

[View Toolbars File}

\View Toolbars Workspace}

\View Toolbars Network}

\View Toolbars )) Molecular Descriptors‘

View

Full Screen| Switches to full screen.




6 CHAPTER 2. GETTING STARTED

2.2.3 Tools

The following options are accessible from the option:

\Tools Peptide querying‘ Opens/selects the query tab in the Tools panel.
Tools )) Peptide search by}

[Tools Peptide search by )) Single Query sequence} Opens/selects the single query tab in the Tools

panel.

[Tools Peptide search by )) Multiple Query sequences‘ Opens/selects the multiple query tab in the
Tools panel.

[Tools ) Peptide search by )) Non-redundant set| Opens/selects the non-redundant set tab in the Tools
panel.

Tools )) Peptide filtering} Opens/selects the filter tab in the Tools panel.
\Tools Molecular features}

[Tools Molecular features )) Extraction )) [molecular descriptor option]] Opens/selects the molecular de-
scriptor tab in the Tools panel.

[Tools Molecular features )) Selection )) [unsupervised feature selectionﬂ Opens/selects the unsuper-
vised feature selection tab in the Tools panel.

[Tools Molecular features Explorer] Opens the feature explorer window.

[Tools Molecular features Removing] Opens the feature removing window.

[Tools )) Network )) Metadata Metadata| Opens the window to generate a metadata network.

[Tools Network )) Similarity Network} Opens/selects the chemical space tab in the Tools panel.

|

|

Tools )) Network Appearance‘ Opens/selects the appearance tab in the Tools panel.

Tools )) Network )) Layout )) [layout algorithm]] Opens/selects the layout algorithm tab in the Tools
panel.

[Tools Network )) Clustering )) [clustering algorithm]} Opens/selects the clustering algorithm tab in
the Tools panel.

[Tools )) Network )) Gentrality )) [measure]| Opens/selects the centrality measure tab in the Tools
panel.

[Tools Network ) Subnetwork mining )) [graph-based algorithm]‘ Opens/selects the graph-based al-
gorithm tab in the Tools panel.

Displays the software configuration window.

2.2.4 Window

The following options are accessible from the option:

[Window Peptide SequenceSI Opens/selects the peptide sequences window in the center panel.
Window )) Network visualization] Opens/selects the network visualization window in the center panel.

Window Properties} Opens/selects the properties panel.
Window ) Navigator| Opens/selects the navigator panel.
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Window Output} Opens/selects the output panel.

Window )) Configure Window [options]] Window settings
Window )) Reset Windows]

Close Window‘
Window )) Close All Documents}

Window> Close Other Documents}
Window ) Documents...| Opens the Document management window.

|
|
|
| Window
|
|
|

2.2.5 Help

The Opens the About information window.

2.3 Quick access bar

1 2 3 4 5 6 7 8[9 10 || 1 12
Li} ) - -| = vf;.. H@‘%-ﬁ.‘.

Figure 2.2: Quick access bar.

Note: These options may be shown/hidden from the menu entry: [View Toolbars [Optionﬂ

1. Shortcut to [File> Clean project‘,

2. Shortcut to [File New workspace},

3. Shortcut to [File Select workspaceL

4. Shortcut to [File Copy data to )) New workspace],

5. Shortcut to [File Rename current workspace‘,

6. Shortcut to [File Remove workspace}_

7. Shortcut to [Tools Molecular features> Extraction}_

8. Shortcut to [Tools Molecular features Selection]_

9. Shortcut to [Tools Molecular features ExplorerL
10. Shortcut to [Tools Molecular features Removing]_
11. Shortcut to [Tools Network ) Metadata Network},
12. Shortcut to [Tools Network )) Similarity Network}_
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2.4 Tool panels: an overview

2.4.1 Query panel

This panel may be opened from [Tools Peptide querying].

Note: The recovered peptides are those linked to the specified metadata nodes.

Query % 1(]2 [3 4 5
Match all (and) v |4 '| % [P Run | ©
[ All peptides 61 -
B
-9 Plantae
4 m }
| Apply query automatically | 7

Figure 2.3: Query panel

Selects the joining condition for the query criteria: |Match all (and)| or |Match all (or)|.
Adds a new term (linked metadata) to the query.

Edits the query term selected.

Deletes the query term selected.

Runs the query.

List of current query terms.

Applies the query automatically with each change.

Nooahkowh =
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2.4.2 Filter panel

This panel may be opened from |Tools )) Peptide filtering|.

[Fter ] (1) [2]3]a 5]
|Matd1 all (and) v| | |% | PR |

Y Llength =24 I 6
Y Origin starts with rana

[ ] Apply filter automatically l 7 ]

Figure 2.4: Filter panel

Selects the joining condition for the filter criteria: [Match all (and)] or [Match all (Or)].
Adds a new filter.

Edits the selected filter.

Deletes the selected filter.

Runs the filter.

List of current filters.

Applies the filter automatically with each change.

Noohkowh =

2.4.3 Sequence search

This panel can be opened from [Tools Peptide search by )) [sequence search option]}_ For instance,
[Single query sequence‘:
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Single query sequence X l l |

Single query sequence v [> Run

Click here to configure... >> 2

Input sequences 3
Search peptides from:

(®) Embedded database

() Current workspace 4

> Query

G?;D Reset 5

Figure 2.5: Single query sequence.

Runs the query.

Configures the sequence alignment (Fig. 2.6).
Selects the target sequences.

Input sequence.

Resets the query.

aokrwn =
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Search

Sequence search - PR | @

<< Click here to enter sequence 1 2]~

Alignment type:  Local (Smith-Waterman) + 13

—

Substitution matrix: | Blosum 62 by Henikoff & Henikoff  : = || 4

m

€) Percent identity: 70%

0

Low Moderate Very Strong

U(‘?) Reset

Figure 2.6: Sequence alignment settings.

Returns to the input sequence view.
Resets the alignment configuration.
Alignment type (local or global).
Substitution matrix.

Percent identity (default: 98%).

ok~

2.4.4 Molecular feature extraction

This option is accessible from the menu option: [Tools> Molecular features> Extraction> [molecular descriptor option]‘_

For instance, |All descriptors :

Note: The calculated molecular descriptors can be removed by accessing the menu options
[Tools> Molecular features> Removing},
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1
All descriptors X =
All descriptors v PR @
MNo. Name i
1 Peptide length
2 Net charge
3 Isoelectric Point
4 Molecular Weight
5 Boman Index
6 Indices based on aggregation operators
7 Hydrophobic Moment
8 Average Hydrophilicity
9 Hydrophobic Periodicity
10 Aliphatic Index
11 Inestability Index [
v
L"'E?,’J Reset

Figure 2.7: Calculating all molecular descriptors.

1. Runs the selected molecular descriptor algorithms.
2. Selects/Unselect molecular descriptor algorithms.

Besides, calculated molecular features can be displayed in the columns list at the center panel
(enabling molecular feature filtering). This option is accessible from the menu option:
Molecular features> Explorer]:
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@ ol

List view ~ Al

length

Z(pH=5)

Z(pH=7)

Z(pH=9)

NetCharge(KLEP840101)
AvgNetCharge(KLEP840101)
NetCharge(CHAMS830107)
\AvgNetCharge(CHAM830107)
INetCharge(CHAMS830108)
\AvgNetCharge(CHAMS30108)

pI

mw

Boman
pH(angle=100,scale=KYT1820101)
pH(angle=160,scale=KYT1820101)
pH(angle=180,scale=KYT)820101)
maxAvgH(KYTI820101)

WH(angle =100,scale=Tossi12)
WUH(angle =160,scale=Tossi12)
WH(angle =180,scale=Tossi12)
maxAvgH(Tossi12)

WH(angle =100,scale=E1SD840101)
pH(angle =160, scale=E1SD840101)
pH(angle =180, scale=E1SD840101)
maxAvgH(EISD840101)
\AvgHydrophilicity (KUHL950101)

Features: 30

13

Displayed columns
Boman

| Load feature values | Boman [ 2 ]
ummary

Max: 14.92 Mean: 1.659
Min: -4.92 Std Dev: 1.818

Histogram

Frequency

<4 -2 0 2 4 6 8 10 12 14

Close

Figure 2.8: Adding molecular features (Boman) to the displayed columns list.

1. Adds/Removes molecular descriptors to/from the displayed columns list.
2. Visualizes the histogram and data summary (max, min, mean, and standard deviation) of

molecular feature values.

2.4.5 Molecular feature selection

This option is accessible from the menu option: [Tools> Molecular features> Selection )) [unsupervised feature selection]]_

For instance, [Filtering & subset optimization]:
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Filtering & subset optimization X 1
Filtering & subset optimization ~ PRn @
Firststage Second stage 2

Feature filtering

Removing useless features

Relevance criteria:  Shannon Entropy

Number of bins: | The number of peptides (7)
Threshold (%): 10 : (1)

Removing redundant features

Correlation coefficent: Spearman

Threshold: 08> @

Ranking output
(®) Select all filtered features

(O Select top |40

Figure 2.9: The two-stage unsupervised feature selection

1. Runs the two-stage unsupervised feature selection.
2. Configures the two-stage unsupervised feature selection.

2.5 Center panels

2.5.1 Peptide sequences window

This window is opened from [Window Peptide sequenceSI. The Peptide sequences window shows
the result of applying a query, filter, or search. The rows showed can also be filtered by attributes

such as , \Sequence}, ['—e”gth‘, or calculated features.
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| Peptide sequences X | ~ 0O

» Fetched: 45,120 Attribute filter: | 1D v |leqdtn o +
Peptide Sequence Length Boman

-:; starPep_00000 GIGAVLKVLTTGLPALISWIKRKRQQ 26 0.5642307692307693 ~

-:; starPep_00001 GIGKFLHSAKKFGKAFVGEIMNS 23 0.41043478260869565

?; starPep_00002 ILPWKWPWWPWRR. | 13 1.0653846153846154

:‘; starPep_00003 KWCFRVCYRGICYRRCR 17 3.532352941176471

:‘; starPep_00004 LLGDFFRKSKEKIGKEFKRIVQRIKDFLRM... | | 37 2.9918918918918918

:‘; starPep_00005 FFHHIFRGIVHVGKTIHRLVTG .22 0.7072727272727273

}l‘ starPep_00006 FLPLIGRVLSGIL |13 -1,5461538461535462

:“ starPep_00007 FWGALAKGALKLIPSLFSSFSKED 24 0.047499999959999951

3“ starPep_00008 GWGESFFKKAAHVGKHVGKAALTHYL |25 0.19520000000000004

:‘. starPep_00009 ACNFQSCWATCQAQHSIYFRRAFCDR .| 36 2.143333333333333

3; starPep_00010 ALWKTMLKKLGTMALHAGKAALGAAAD .. | | 34 0.15735294117647056

-:; starPep_00011 FLPLLAGLAANFLPTIICKISYKC 24 -1.2708333333333337

-:; starPep_00012 FLPYLAGIAAKVVPALFCKITKKC 24 -1.2020833333333334

?; starPep_00013 GLLSVLGSVAKHVLPHVVPVIAEHL .25 -1.0467999999399997

:‘; starPep_00014 GLNTLKKVFQGLHEAIKLINNHYQ |29 0.91375

:‘; starPep_00015 HVDKKVADKVLLLKQLRIMRLLTRL .25 16532

:‘; starPep_00016 IWLTALKFLGKHAAKHLAKQQLSKL .25 0.23750000000000006

}; starPep_00017 KTCEHLADTYRGVCFTMASCDDHCKNE... | | 46 2.0821739130434778

}l‘ starPep_00013 KWHKLFKKIEKVGQNIRDGIIKAGPAVAVY. . | | 37 0.8372972972572975

:“ starPep_00019 LCNERPSQTWSGNCGNTAHCDKQCQD .| 50 2.745799999939599

:‘. starPep_00020 RGGRLCYCRRRFCVCVGR .18 3.652222222222222

3; starPep_00021 ACYCRIPACIAGERRYGTCIYQGRLWAFCC | 30 1.0763333333333331

-:; starPep_00022 ALWKMMLKGIGKLAGKAALGAVKKLVGAES 30 -0.26633333333333337

-:; starPep_00023 DHYMCVSSGGQCLYSACPIFTKIQGTCY .. 36 1.30335833653888387

-:; starPep_00024 DKLIGSCVWGAVNYTSDCNGECKRRGY .. 44 1,7445454545454544

?; starPep_00025 FRCRRWQWRMKKLGAPSITCVRRAF .25 2.7455959999999996 W

Figure 2.10: Peptide sequences window

2.5.2 Network visualization window

This window is opened from [Window Network Visualization]. It consists of two views: and
[PrevieWI. The iScenei view allows to customize some visual properties of the network such as back-
ground color, zoom, position, and individual colors for edges and nodes. The options highlighted
in Fig. 2.11 are the following:

Switch background.

Zoom options.

Selector. It allows to change the node diameter of the cursor while selecting nodes.

Additional options. It allows to enable or disable the options |Autoselect neighbors| and | Show peptide labels|.

Note: we recommend disabling the latter in order to render clearer graphs in metadata net-

work analysis.

5. More advanced sizing and coloring options for nodes. By pressing , the options
are shown/hidden.

. Network rendering area.

7. Node label options. The first one allows to show/hide the node labels. The second one

brings three options to modify node label size: [Fixedi, \Scaie sizei, and . Note: The

option is handy for adjusting the label size proportionally to the node size. The

third one modify the label color options. There are three choices: , , and .

. Node label font properties.
9. Node label size.

L=

»

o
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10. Two edges options. The first one shows/hides edges. The second one enables edges to
have the attached node color.

11. Edge thickness.
12. Shows/Hides edge labels.
13. Edge label font properties.
14. Edge label size.

Network visualization 3
Scene | Preview IJ al e X ,_I r|::-f-;.'e __::_,' ‘?Mnre,..l

1] (2 325 6|

AMSDb DAMPD

® AMPer
DRAMP LAMP_Experimental of
CAMP_Validated
’ s DADP
YADAMP
: UniProtKb

APD | CAMP“Patent

DBAASP r
ANTISTAPHYBASE

L]

CancerPPD ¢
I‘_[7 8 9 0] [1n)[12])(13) [14]
T I | L friaitesria, 32 | |

]A- A- Jpriainegrita, 32 I [N

Figure 2.11: Network visualization window: Scene view.

Note: When you right-click the mouse on the scene view, a context menu is displayed.

The view shows the rendered the graph according to the calculated layout and all the
configurations. Attractive networks may be rendered in this other view. To update the drawing,

press the button.
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Network visualization
Scene ‘ @ Refresh | B Jg Jd| @ settings

Figure 2.12: Network visualization window: Preview view.

2.6 Navigator panel

This panel is opened from \Window Navigator}. The navigator changes between the \Metadata relationships[

and |Graph table options according to whether the [Peptide sequences} or [Network visualization} window is
active.

On the one hand, in the \Metadata relationshipS} view, the user can seek metadata nodes. Right-
click on a row will show a context menu to select or center nodes on the graph, as well as the

window for the relationship.

Note: If a peptide sequence is selected in the center panel, only the related metadata are
shown in this navigator panel. Click on the button to show all.
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Navigator = —
Metadata relationships w | |- All metadata - e l-fgﬂ | ]
Peptide Label Metadata
starPep_14013 compiled_in ParaPep ~
starPep_14013 compiled_in SATPdb
starPep_14013 related_to Antiviral
starPep_14013 related_to Antimicrobial
o ————

starPep_14013 related_to §|Ed on graph ° Edge
starPep_14013 related_to enter on graph Source
starPep_14013 related_to Properties Target
starPep_14013 related_to AMTCAnCEr
starPep_14013 related_to Antimalarial
starPep_14013 related_to Antiplasmadial
starPep_14013 assessed_against Plasmodium
starPep_14013 linked_to PubMed: 23034275
starPep_14013 modified_by Boc=Tert-Butyloxycarbon...
starPep_14013 modified_by Othu
starPep_14013 Ome

modified_by

» Relationships: 37.729

Figure 2.13: Navigator for the Peptide sequences window

On the other hand, in the view, the user can switch the view from nodes table to
edges table, and also customize the columns (such as network measures) shown in the data grid.
These data tables can be exported to an external text file (CSV format). There is also a context
menu that is accessed via right-click on any row.
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Mavigator X |

Graph table

“ | Node Edge | Q | |l Columns... |E

Mame
|starPep_00000
HIPdb

ADAM
DRAMP_Patent
StraPep

RAFD
CAMP_Patent
MeuroPep

Y ADAMP
ParaPep
DEAASP

AVPdb
BaAMP
LAMP_Patent
APD

CAMP_Validated

Degree Label
22 Peptide
14 Database
335 Database
130 Databaze
&0 Database

Select on graph
Center on graph

Properties
273 Derooamc

&7 Databaze
1.218 Database
257 Database
22 Databaze
32 Database

13 Database
350 Database

b Modes: 1,863 | » Edges: 6.547

Figure 2.14: Navigator for the Network visualization window

19
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Working with networks

3.1 Metadata network

The construction of metadata network is accessible from the menu option: | Tools ) Network ) Metadata Network

&

Select the metadata to display as neighbor nodes

(®) Mone

() Database
() Function
() Origin

() Target
() CrossRef
() Mterminus
() Cterminus

() Unusualaa

Cancel

Figure 3.1: Options for metadata network

In metadata networks, nodes representing metadata are connected to nodes representing
peptides by the following relationships.

20



3.2. SIMILARITY NETWORK 21

Metadata node Relationship
Origin produced_by
Target assessed_against
Function related_to
Database compiled_in
Crossref linked_to
Nterminus modified_by
UnusualAA constituted_by
Cterminus modified_by
Subcategory of another node is_a

Table 3.1: Metadata node names and relationships in starPepDB.

3.2 Similarity network

The construction of similarity network is accessible from the menu option: [Tools Network ) Similarity Network ,
To create a similarity network, we first recommended to configure the workflow using the Configu-
ration Wizard and then press the button Run.
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Chemical Space % |

Nodes | Edges| 3

PCA coordinates 4| @ aeoly

X axis: |PCA 1 (27.70% explained var.) 5

Y axis: PCA 2 (14.99% explained var.) =
Factor Explained variance Cumulative variance 6

'Mapping and Visuaization 11 Pran |©
Network 2 E::'\’\Cnnﬁgure... =

m

Reset 7

®

Figure 3.2: Chemical Space window (Nodes tab).

Runs the workflow for building the similarity network.
Opens Configuration Wizard (Sect. 3.2.1).

Changes between Nodes and Edges tabs.

Applies PCA coordinates changes.

Selects X and Y axis for PCA coordinates.

PCA results panel.
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‘ Edges |

Similarity threshold @ Apply

Current value: 0,00

oV ®

0 0.t 02 03 04 05 06 07 08 0.9 il

Network Density zl

0.060 e e
0.055
0.050
0,045
0,040

0,035

0,030

0,025

Value

0,020
0.015
0,010
0,005
0.000

oo 01 02 03 04 05 06 07 08 09 10
Similarity threshold

Figure 3.3: Chemical Space window (Edges tab).

1. Similarity threshold selector. After changing the value, it is necessary to press "Apply”.
2. Network Density plot. Helps to decide a similarity threshold.

3.2.1 Configuration wizard

This section will show the configuration wizard for mapping and visualizing the Chemical Space.

Wizard Step 1: Input sequences

To remove redundant sequences, press Yes (recommended). Then, you can choose between
local or global alignment, multiple substitution matrices, and a identity threshold.
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@
| Steps Input sequences
| 1. Inputsequences Select input peptides from:
| 2 Feature extraction
| 3. Feature selection (_) Embedded database
| 4. (Dis)similarity metric
| 5 Metwork model (®) Current workspace

Do you want to remove redundant sequences?
(D No
(@ Yes

Alignment type: | Local (Smith-Waterman) ~
Substitution matrix: |Blosum 62 by Henikeff & Henikoff v

€D Percentidentity: 98%

Reset to Default

Wery Low Low Moderate Strong
Back Finish Cancel Help

Figure 3.4: Wizard Step 1: Input sequences.

Wizard Step 2: Feature extraction

If you already calculated a set of molecular descriptors, you can select the first option and press

Next. If not, select the new descriptors to be calculated.
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r "
%! Chemical Space Mapping and Visualization P —— ﬂ
Steps Feature extraction
12" ;zn%ﬁ::‘c:;“ What do you want to do?
3. Feature selection o [se the ava
4. Distance function
5. Full/HSP netwark ") Compute new set of molecular descriptors
No. Name
1 Length
2 Met charge
3 Ispeleciric Point
4 Molecular Weight
5 Boman Index
1] Indices based on aggregation operators
7 Hydrophobic Moment
8 Average Hydrophilicty
9 Hydrophobic Periodicity
10 Aliphatic Index
i1 Inestabiity Index

Wl [ Next> | [Wl [W] Help

Figure 3.5: Wizard Step 2: Feature extraction

Wizard Step 3: Feature selection

If you plan to use all available descriptors, select the first option, and press Next. If not, select and
configure the two-stage unsupervised feature selection method.
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| Steps Feature selection
: 1.  Inputsequences 2
| 2 Feature extraction What do you want to do?
| 3. Feature selection (7 Use all features

4. (Dis)similarity metric

5. Metwork model

(®) Unsupervised feature selection

First stage  Second stage
Feature filtering
Removing useless features
Relevance criteria: | Shannon Entropy -
Mumber of bins: | The number of peptides { n) -~

Threshold {%): 10 : (1]

Removing redundant features

Correlation coeffident: |Spearman

Threshold: 0,8 €

Ranking output

(@) Select all filtered features

() Select top |40

< Back Einish Cancel Help

Figure 3.6: Wizard Step 3: Feature selection.

Wizard Step 4: Distance function.

Select the desired distance function and the standardization/normalization for the calculated des-
criptors.
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| Steps (Dis)similarity metric
| L Input Sequences Please, select a (dis)similarity metric
| 2 Feature extraction .
| 3. Feature selection ’f-, (Dis)similarity metric Option:
| 4. (Dis)similarity metric - Manhattan (@) Z-5core standardization
| 5 Metwork model [N clidean
-# Chebyshev () Min+Max normalization
# Canberra e
- Soergel _"c
-4 Bhattacharyya Eudidean
# Angular separation
------ # Wave-Edge

< Back Einish Cancel Help

Figure 3.7: Wizard Step 4: Distance function.

Wizard Step 5: Network model

For generating a network model, select between the Half-Space Proximal Network or the traditional
Similarity Network (not recommended for large datasets). For more details, please refer to the
main paper.

Note: The position of nodes may be determined by the first two principal components of de-
scriptor space. However, layout algorithms are recommended for a better rearrangement of nodes.
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| Steps Network model
: 1.  Inputsequences - e
| 2 Feature extraction What kind of network do you want to build?
3. Feature selection Half-space proximal network - Update nede positions based on PCA {20 map)
| 4. (Dis)similarity metric
| 5. Network model

[]reverse order §H

< Back Mext = Cancel Help

Figure 3.8: Wizard Step 5: Network model.

3.3 Network model options

After creating the network model, the following options are available.
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Nodes FEdges Embed

PCA coordinates @ Apply changes
X axis: v
Y axis: v

Figure 3.9: Network model options.

—

. Positioning nodes.

2. Adding/removing similarity edges.

3. Embedding new peptides. When new peptides are projected, a network model will be
opened into a new workspace.

3.4 Layout algorithms

A layout algorithm option may be opened from [Tools Network ))Layout )) [layout Option]]. The main
graph Iayouts available are [Fruchterman ReingoIdL [ForceAtIas 2], [Yifan Hu Proportional], and [Random Layout]_

Any layout result could be adjusted using the options \Rotatel, \Contraction}, [EXpansionL [Noverlap‘, and

Laoet At

Note: is recommended to handle large networks while keeping a very good

quality. |[Random Layout| may be a good start point for applying new layouts. [Fruchterman Reingold‘ and
|Yifan Hu Proportional| may be used for small or middle size networks.

Layout X | —
Fruchterman Reingold e [> Run 6
[=| Fruchterman Reingold

Area 10000.0

Grawity 10.0

Speed 1.0

Figure 3.10: |Fruchterman Reingold] option_
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3.5 Appearance
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This panel is opened from \Tools Network )) Appearance|,

So® N o

Appearance 2

Appearance - PR |1

fleccs | ®©|A|T

Unigue | Partition Ranking li 51l617|8

4 Reset...

9

Color: | #91bd00 —

Lfé’v)Reset 10

Figure 3.11

. Runs the appearance customization of either nodes or edges. Note: if the window

is active in the [Network visualization} window, you need to press the button from said

window to update the network view.
. Selects the elements (either [NodeS} or \EdgeSI) whose appearance is to be changed.
. Applies configuration via |Uniquel, |Partition|, or |Ranking| functions. For nodes, the calculated

measures are available as [Partition} or [Ranking} options.

. Modifiable configurations panel. For color options, you need to press and drag the cursor to

the desired color, or press right-click to open the color window.

Changes the color of either \NodeSI or \EdgeSI (if edges are not taking the color of attached
nodes, see sect. 2.5.2).
Changes size (this option only applies to nodes).
Changes label color of either [Nodes| or |Edges |

Changes label size of either |Nodes| or |Edges|.

Resets current options.
Resets customization to the default appearance.
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3.6 Clustering

A clustering panel (Fig. 3.12) may be opened from [Tools Network )) Clustering ) [clustering algorithm]].

For instance, :

Note: After running the clustering algorithm, you may visualize the network structure in
Network )) Appearance )) Nodes Partition]_

Clustering X| —_

K-Means w [ Run | €®
=l Properties

Mumber of clusters &

Wax iterations 500

Distance function 2

Figure 3.12: k-means clustering option.

3.7 Centrality

A centrality panel (Fig. 3.13) may be opened from [Tools Network )) Centrality )) [measure option][_ For
instance, [Betweenness Centrality}:

NOTE: After running the centrality measure, you may customize the appearance of nodes
according to the centrality values in [Tools Network )) Appearance )) Nodes Ranking}.

Measure % |
Betweenness centrality | » |W| o
-/ Properties A
Normalize v -
Betweenness centrality 7]

¥ Ppresets... & Reset

Figure 3.13: Betweenness Centrality option.

3.8 Case study

In this case study, we try to answer the following questions for a given sequence of interest.
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>Example sequence
FLPAIVGAAGQFLPKIFCAISKKC

3.8.1 Which biological database holds peptides similar to the sequence of inte-
rest?

Step 1: Opens the Search panel with the commands [Tools Peptide search by )) Single query Sequence].
Types the query sequence in the input field, configures the sequence alignment at 70% of se-
quence identity, and press . This search should return 25 peptide sequences and 595 meta-
data relationships.

Single query sequence X | =

Single query sequence - [ Run | &

Click here to configure.., > ~

Input sequences
Search peptides from:
(®) Embedded database

() Current workspace

= Query
FLPAIVGAAGQFLPKIFCAISKKC

Figure 3.14: Sequence search panel

Step 2: Creates the metadata network by selecting the option Database.
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@

Select the metadata to display as neighbor nodes

() None

(®) Database
(") Function
() Crigin

() Target
() CrossRef
() Nterminus
() Cterminus

() Unusualaa

Cares

Figure 3.15: Options for metadata network

Step 3: In the graph table view of window, select the option and then mark

Degree and click OK.

rs Ny
i Display settings ﬁ

Choose columns to display:

I [
Label

Mame

=]

Figure 3.16: Display settings

We can sort the graph table by node Degree by clicking the Degree column 2 times, and now
we can observe that the database SATPdb contains the most similar sequences to the query
seqguence.
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MNavigator > —
Graph table ~ | Mode Edge | L | T columns... | =
Mame Label Degree N
DADP Database 20
YADAMP Database 19
APD Database 19
|DF‘.AMF‘_General Database 13
dbaMP Database 19
ADAM Database 13
DBAASP Database 13
CAaMP_Validated Database 18
LAMP_Experimental Database 18
starPep_00026 Peptide 17
starPep_00027 Peptide 17
starPep_00023 Peptide 17
starPep 00029 Peptide 17
starPep_00030 Peptide 17 v
) M“;- Modes: 4-4H - | ¢ Edges: 268 -

Figure 3.17: Graph table

3.8.2 What are the biological functions of peptides similar to the sequence of in-
terest?

Follow the Step 1 of the previous example.

Step 2: Creates the metadata network by selecting the option Function.

Step 3: In the graph table view of window, select the option and then mark

Degree and click OK.
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MNavigator = |

Graph table » | Mode Edge | ] | | columns... | &)

Mame Label Degree N
Antibacterial Function 24
Antifungal Function 20
Anti-Gram negative Function 19
Anti-Gram positive Function 13
starPep_00423 Peptide 12
starPep_00423 Peptide 11
starPep_00429 Peptide 11
starPep_00619 Peptide 11
starPep_00634 Peptide 11
starPep_00963 Peptide 11
Toxic to mammals Function 10
Toxic Function 8
Anticancer Function 7
Antiviral Function 7
o » Modes: 3?-"'_ I | » Edges: 151 B

Figure 3.18: Graph table

Step 4: In the [Network visualization] window, select the following options.

35
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Peptide sequences x| Network visuglization X ‘

CHAPTER 3. WORKING WITH NETWORKS

Scene  Preview ‘ y O | @ & [,_‘ Iy configure..|| [& = | © More... |
2
Cytdtoxic
Antiféingal
™ a
Antiviral
Anti-Graf positive ®
®
&
)
Antitamor
o & = Tokic "
L Fa)
o Antimigrobial . ®
. . *
[
o ]
. Anti-Grarff negative _
Anticancer Antibacterial
Toxic to fiammals
®
Hem@lytic
A- Arial Negrita, 32 I ‘ I 1" Arial Negrita, 32

1. Shows node labels.

Figure 3.19: Network visualization

2. Disables the option |Show peptide labels |,

3. Modifies the label size to [Node size|.

In the panel (see sect. 3.5), customizes the appearance of nodes for sizing and
coloring nodes according to the degree measure.

1. In the view, select \Node size )) Ranking Degree}. Set min and max sizes to 5 and 100

respectively, select the interpolator |Bezier|, select the second predefined spline and press

Run|,

2. Inthe view, customizes [Node color )) Ranking )) Degree|, and press [Run|

Run the [Tools Network ) Layout )) Fruchterman Reingold] about 10s and then press stop. The result
may be similar to the following network:
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mr@uu ' . 3 . star l:!
- Antifniembial .

o - A_mm@gm
®

il &
el

Figure 3.20: Metadata network
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